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PGA EUROPEAN TOUR

COMMAND SUMMARY

WARNING:

READ BEFORE USING YOUR SEGA VIDEO GAME SYSTEM.

A very small percentage of individuals may experience
epileptic seizures when exposed to certain light patterns or
flashing lights. Exposure to certain patterns or backgrounds
on a television screen or while playing video games may
induce an epileptic seizure in these individuals. Certain
conditions may induce previously undetected epileptic
symptoms even in persons who have no history of prior
seizures or epilepsy. If you, or anyone in your family, has
an epileptic condition, consult your physician prior to
playing. If you experience any of the following symptoms
while playing a video game — dizziness, altered vision, eye
or muscle twitches, loss of awareness, disorientation, any
involuntary movement, or convulsions - IMMEDIATELY
discontinue use and consult your physician before
resuming play.

In the Pro Shop A B C

A

Selects a highlighted menu item. Confirms (OKs) a choice.
B

Toggles options from Setup Menu on/off.

C

Cancels menu selection.

'WARNING To Owners of Projection Televisions!

Still pictures or images may cause permanent picture-tube
damage or mark the phosphor of the CRT (television
screen). Avoid repeated or extended use of video games on

large-screen projection televisions.

Start
Activates/Deactivates Menu Bar. Cancels menu selection.

D-Pad

Left/Right displays different menus. Up/Down highlights menu
iems.
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WELCOME TO PGA EUROPEANTOUR™

Welcome to a whole new world of golf! Now you can play some
of the most exciting courses on the European Tour while testing
your prowess against the finest international players. We've
included all of the great features that were in PGA TOUR Golf
I, plus we've added some special items to make this game
unique. There is a new Shoot-Out play mode as well as a Match
Play option, with literally pounds of money riding on the
outcome of the contests. You'll also notice clear improvements
in the graphic presentation of the game which make it more real
than ever. So grab your clubs and your passports and head for
the links!

STARTING THE GAME

|. Turn OFF the power switch on your Sega' " Genesis
Never insert or remove a game cartridge when the power is
on.

. Make sure a Controller is plugged into the port labeled
Control 1 on the Genesis Console. If you want to use two or
more controllers, see Serup, page 7.

- Insert PGA European Tour™ into the slot on the Genesis.
To lock the cartridge in place, press firmly.

4. Turn ON the power switch. The EA SPORTS"™ logo appears
(1f you don’t see it, begin again at step 1).

. The PGA European Tour title screen appears, followed by
the game credits screen.

6. If you want to play right away, press Start to go to the Pro

Shop.
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Tournament
Skins Challenge

Match Flay
Sheot-0ut

Driving Range
Putting breen

Starting a Practice Round

|. Press Start to bring down the Play Menu.

Practice Round is automatically highlighted. Press A to select

Practice Round.

3. The Select Number of Players Box appears. D-Pad left/right
to highlight desired number of players, and press A.

4. New Player is automatically highlighted. Press A.

The Players Card appears. D-Pad up/down to select letters

and left/right to enter letters and move the cursor. When

you've entered a name, press Start.

6. The Tee Selection Box appears. D-Pad left/right to select
your tees, and press A.

7. The Club Selection Box appears. If you want to substitute one
or more clubs. follow the on-screen instructions, or see page
31. Press A to continue.
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8. The Select Course Box appears. D-Pad up/down to highlight
a course, and press A to select it. In a moment you find
yourself on the first tee. Good Luck!

CONTROLLING THE GAME
elup

"1 there are more than one of you playing and you each want to
use your own controller, (instead of passing one back and forth),
vou need to set up the system for two or more controllers. One to
tour people can play PGA European Tour at a time.

. From the Pro Shop, press Start to reveal the Menu Bar.

- D-Pad right to reveal the Options Menu.

. D-Pad down to highlight Serup, and press A. The Setup Box
appears. When an option is active on the Setup Box, the
letters are brightly lit. When an option is inactive, the letters
appear dim.

4. Use the D-Pad to highlight Two or More Controllers, and
press B to toggle it on/ofT.

- Press A to confirm your choice and return to the play screen.

bl 1) ——
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L'sing Two Controllers

When both controller jacks are active, Player #1 and Player #3
use Controller 1, while Player #2 and Player #4 use Controller 2.




I'sing the 1-Way Play™ \dapter

Plug the 4-Way Play into your Genesis, then plug up to four
controllers into the adapter, and you're ready to go. Player #3
uses Controller 3 and Player #4 uses Controller 4.

NOTE: Six-button controller users who are using the
4-Way Play must play in three-button mode.

To configure your six-button controller to three-button
mode:

|. Turn off the Genesis.

2. Press and hold the “Mode™ button on every six-button
controller that will be used while you turn the Genesis on.

Y our six-button controllers are now configured in three-button
mode.

BASICS FROM THE CLUB PRO

Flag stick Aiming cursor

Name of
current

volfer

Current
Wind sSCore
cange

Distance
lo cup

Distance potential Shot tvpe

"hroughout PGA European Tour, there are menus to help you
play and move you through the game. While specific
mstructions for each menu and aspect of game play are included
within this manual, certain constants remain the same and are

listed below.

* Press Start to reveal the Menu Bar at the top of the play
screen.

* Press the D-Pad left/right to select menus, and press it
up/down to highlight various options within a menu.

* Press A to confirm a highlighted menu option.

* Press Start to leave the title, credit and hole preview screens.




careful if you choose to go into this area; if you fail to hit the
accuracy point, the results can be costly. All hooks and slices are

magnified in direct proportion to the degree of power you have
chosen. Overswing, by definition, eliminates reliability.

HITTING THE BALL
The Stroke Meter and the Accuracy Point Oraw and Fade Meter

Marker

Distance potential Overswing area Power bar  Accuracy point

I7 57 S7. 257

The Stroke Meter is the tool you use to determine the strength of You might want to hook or slice the ball intentionally to avoid a
your shot. The Accuracy Point is the spot on the Stroke Meter hazard. The best way to control a hook or slice is to set the
that you use to determine the direction of your shot. An Draw/Fade Meter before you swing, then hit the accuracy point
important skill to develop is stopping your swing exactly on the as usual. The Draw/Fade Meter is not available when you’re
accuracy point; if you do your shot goes straight. If you miss the putting.
accuracy point to the right, the ball slices right. If you miss the
point to the left, the ball hooks left. The greater your distance * Press and hold C to bring up the Draw/Fade Meter.
from the accuracy point, the greater the degree of the hook or * D-Pad left/right to adjust the marker.
shice.

Selecting the Proper (lub

|. Press B to start your backswing.
2. Press B again to stop your backswing and begin your swing.
3. Press B a third time to hit the ball (at the accuracy point).

I'he program automatically selects a club for every situation, but

you don’t have to use it. Many factors, including wind and ball
lie, can influence your club choice.

(verswing

The area to the left of the 100% mark on the Stroke Meter is the
“overswing” area. If you venture into the overswing area, you

can increase your potential power and hit the ball farther than the o
maximum distance potential listed on the Stroke Meter. Be ' —

* To change clubs, D-Pad up/down.




The name of the selected club appears at the bottom of the
information box in the lower right corner of the screen. Each
club has different characteristics, one being its maximum
distance potential. When we talk about distance potential, we're
referring to rotal, not aerial, distance. These potentials assume a
perfect lie, no wind, and a flat spot for the ball to land so it can
bounce and roll. The distance potential of a club is shown at the
left side of the Stroke Meter.

(alculating Your Shot

There's more to hitting the ball than simply aiming the cross
and swinging the club. You should take into consideration the
wind, the ball lie, your follow-up shot, and the potential haza
on the course itself. Let’s say your driver’s distance 1s 270 ya
If you stop your backswing when the Stroke Meter reaches 50%
your shot’s calculated distance will be 135 yards, but this can be
affected by the above factors.

Aiming Your Shot:

The aiming cross hair (flashing in the middle of the screen when
you're about to hit) indicates the direction the ball will travel if
you hit square and there is no cross-wind.

* To adjust the aiming cross hair, D-Pad left/right.

Cauging the Wind:

The rotating arrow at the bottom left of the screen
indicates the wind speed and direction. Watch out for
occasional gusts and pay attention to the weather
report given before each round.

B NOTE: The short irons impart a greater arc to the shot
than do woods and long irons. Consequently, the higher
the arc of the shot, the more the wind will influence the

flight of the ball.

DRIVING RANGE

l-ach course has its own Driving Range. To prepare for an
upcoming tournament, practice all your shots at the Driving
Range. Experiment with woods and irons, special shots, and the
Draw/Fade Meter.

' Highlight Driving Range on the Play Menu and press A. The
program takes you to a Driving Range.

. To change courses while on the Driving Range, select New

Course from the Go to Menu and press A. The Select Course
Box appears.

3. Select a Course and press A.
4. To leave the Driving Range, select Pro Shop from the Go to

Menu, and press A.




PUTTING

Cup window

fer rh{'
cup

Stroke meter Elevation of ball
in relation to cup

PGA European Tour allows you to practice putting on any of
the greens in the game. Good putting can make or break a
player, and many a game has been won (or lost!) on the green.
Before going on the Tour, you may want to practice your
putting.

* From the Pro Shop or PGA Tour Tent, highlight Putting
Green from the Play Menu, and press A.

Changing Holes or Courses

' he program automatically takes you to the Ist green of a
randomly selected course.

Lo Go to a Different Hole:

. Pull down the Go to Menu and select Hole.

2. Press A. The Select Hole Box appears.

Use the D-Pad up/down or left/right to highlight the hole you
want, and press A to confirm.

-

0 Go to a New Course:

- Pull down the Go to Menu and select New Course.

'. Press A. The Select Course Box appears.

- D-Pad up/down to highlight the course you want, and press A
to confirm.

-

How (o Putt

'he Stroke Meter on the green works just like anywhere else.
* To putt, Press B three times. To refresh your memory on how
to use the Stroke Meter, see The Stroke Meter and The

Accuracy Point on page 10.

I he distance potential of your putter can be changed in
mcrements of S feet over a range of 5 to 120 feet.

* To change the distance potential, D-Pad up/down.



The program randomly chooses pin and ball placement. After
you sink a putt, this placement changes. If you want to change
the position of the ball or cup before you putt, select Pick up
Ball from the Shot Menu and press A.

To practice a specific putt over and over again, select Take a
Mulligan from the Shot Menu and press A.

Lrid View

When you select Putting Green, a contour grid showing the
topography of the practice hole’s putting surface appears on the
screen before each hole. A message above the grid reports how
far the ball is above or below the pin, and the exact distance to
the cup. To get a better view of how the topography affects the
roll of the ball, rotate the grid.

* Torotate the grnd left/right, D-Pad up/down.

v ou may also fine tune your aim by adjusting the aiming cross
hair from the contour grid.

o move the cursor left/right, D-Pad left/right.

Press START to return to the Putting Green. Notice that the
aiming cross hair on the green reflects any changes you made
on the grid. Also note that the info box in the lower left hand
of your screen displays the distance and cup elevation as well.

When you're out playing a round and you're on the green or
within 40 yards of the cup, you can access the green grid.

* Press A when you're on the green to see the grid.
* Select Green from the View Menu when you're near the
green to see the grid.

The Secret (o Putting

the green grid provides two critical pieces of information: the
clevation of the ball with respect to the cup, and the contours of
the putting surface. Reading the breaks of a green can be tricky
and requires practice. There are no fixed rules for determining
just how much you should compensate with the aiming cross
hair for a break, but below are a few reliable guides.




 The breaks in the green influence the ball more as the ball
slows down. It’s more important to compensate for the breaks
around the cup than for those directly in front of the ball.

» When compensating for a drastic break, keep in mind that the
ball must travel farther to the cup and plan your distance
accordingly.

« Particularly on short putts, it’s generally a good idea to hit the
ball too hard rather than too soft; don’t try to cozy your short
putts. On the other hand, if you're “lipping™ a lot of your
putts, try hitting the ball a httle softer.

To leave the Putting Green, select Pro Shop from the Go to
Menu.

VIEWING THE COURSE

There are several different ways to view a course. These
alternate views give you insight into the potential hazards and

help you play the best round of golf possible.

verhead View

' he Overhead View is best used in measuring long shots,
particularly when there are hazards or trees involved.

\When you're on the tee:
|- Press A to bring up the Overhead View.
Press any button to return to the course.

\WWhen you're between the tee and the green:

. Press START to call up the Menu Bar.

. Use the D-Pad to highlight Overhead from the View Menu.
Press A. The Overhead View appears.

I Press any button to return to the course.

When in the Overhead View Screen, you can move the cursor
vith the D-Pad to measure the distance between the ball and any
pot on the course. The Overhead View also shows the location
ol your opponent’s ball after the tee shot.

pa o i’#‘




* Press Start to bypass the Fly-By Hole Preview, or go to the
Setup Box in the Options Menu to deactivate it (see Auto-
Fiews on page 22 for detailed instructions).

g ke e
. 4

B>  NOTE: Unlike the green grid view, when vou reposition
. : ) .

the cursor on the Overhead View the t’htl!{ﬂt* IS nol ”III'I' I||‘ll“ s\

reflected on the Course Play Screen.

he Hole Browser provides a user-controlled fly-by of the entire

‘ hole and offers more detail than the Overhead or Fly-By views.
Ball Lie
The Ball Lie Window shows you what kind of terrain your ball | Select Hole Browser from the View Menu.
+ - . - - l‘_ " - L . .
is resting on. See Fine Points From the Master on page 42 for D-Pad up/down/left/right to browse the hole.
" e . e s B il R
more on the different hes. Press B to switch views.
.. Press C to resume game.
= . beace B v - - . - .
* Press A (unless you're on the green) to check your ball he. ’ress Start for Help instructions.
Fly-By Hole Preview Lnstant Replay

| he program automatically shows an instant replay after an
outstanding shot, but you can replay any shot you like, even
those made by the pros.

Select Instant Replay from the View Menu.
Press A. The last shot is replayed.
Press Start to cancel Instant Replay.

The Fly-By Hole Preview appears at the beginning of every
hole. It gives you a sweeping aerial view of the hole. A pro
appears on the screen, offering advice on how to play the hole.

_—
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Auto-Views
Set Options

fverhead louto-view)
Ball Lie lauto-view)

S lauTo-view

i =

Fly-by Hole Preview
Use 2 0or more Controllers

You can activate/deactivate some of these views to be shown
automatically.

I. Select Serup from the Options Menu. The Setup Box appears.

2. Use the D-pad to highlight the feature you wish to activate or
deactivate, and press B.

3. Press A to confirm your choice.

Auto Overhead appears before your shot every time the ball is
more than 100 yards from the hole.

Auto Ball Lie appears before your shot whenever the ball lies
between the tee and the green.

Auto Greens appears before your putt, whenever the ball is on
the green or within 39 yards of the hole.

\uto Fly-by Hole Preview appears at the beginning of every
hole, before you tee off,

* To bypass a view, press Start at any time.

STATS

PGA European Tour offers a variety of stats which are listed
under the Stats Menu.

Teurnament

atgecirc
| = J - e
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Tourney Results

Lurrent Players

I his screen shows the stats for all the players currently in your
party. You have access to these stats only during a game. A
player’s stats are updated every time s/he plays in a Tournament,
skins, Match, or Shoot-Out.

* Select Current Players from the Stats Menu and press A. The
Current Players Stats Screen appears.

iHeset Stats
Y ou can reset a human player’s stats from the Current Players
Stats Screen.




|. Press Start. A dialogue box appears with a list of the current
players. It asks you which players’ stats you would like to
reset.

D-Pad up/down to select a player, and press A to confirm. A
second dialogue box appears.

You are asked to verify your decision to reset stats. Press A 1o
confirm and C to cancel. For human players, the stats return
to zero. If you are playing with a Genesis pro, the stats return
to their programmed base stats.

4. Press C to exit the stats screen and return to the game.

g
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NOTE: You may also reset the pros stats from the Optio
Menu. Select Reset Pros and press A to confirm.

Some of the stats (Longest Drive, Earnings, Best 18 holes, etc.,)
are self-explanatory. Below is an explanation of the statistical
categories that might not be so obvious.

Driving Acc., or “Driving Accuracy.” An accurate drive is one
that stops on the fairway or the green. This stat shows the
percentage of times a player drives the fairway or the green.

Gireens in Reg., or “Greens in Regulation.” On a par 3, your ball
must reach the green on your drive; on a par 4, the ball must
reach the green on your second shot; a par 5, the ball must reach
the green on your third shot to be considered on the green in the
rezulation number of strokes. This stat shows the percentage of
imes a player makes the green in the regulation number of
trokes.

Putts/G.LR. (Greens in Regulation) is the average number of
putts it takes to sink the ball when you reach the green in the
regulation number of strokes. Ideally, a golfer should reach the
creen in regulation and putt twice to hole out: this is the basis of
par. This stat shows the average number of strokes it takes a
player to hole out after reaching the green in regulation.

Par Breakers shows the percentage of times a player beats or
‘breaks™ par.

Par Saves are those holes in which a player shoots or breaks par
without making the green in regulation.

\vg. Par stats indicate the average number of strokes a player
lakes on the par 3s, 4s and Ss.
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Saved Players

These stats correspond in content with current players, but

indicate stats for all saved players, not just those currently
4 . 3 e . ™ w ¥ » . . “1 w Y H P H ¥ ‘ |

playing. As with the current players, you can reset the stats from B p———————
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Tournament

The Tournament stats begin with a list of Leading Money
Winners ranked in order of carnings.

ar scores appear in blue, scores lower than par appear in red,

i | . and above-par scores appear in black.

* To page rapidly through the list, press A. P ppe

* Toreturn to the course, Pro Shop or PGA Tour Tent, press
Start.

Leaderboard

' he Leaderboard lists all the players in an ongoing tournament
in order of lowest total score. The names of human players
appear in blue both on the list and below the list in a separate
Scorecard arca. Next to the name of each player is his current score in
relation to par. Next to the “Par’ column is the “Hole™ column,
which indicates the current hole for that player. A double dash
(— —)in this column indicates the player has finished the round.

After the list of Leading Money Winners comes the list of
Leading Scorers ranked in order of lowest average score for |8
holes.

* To return to the course, Pro Shop or PGA Tour Tent, press
Start.

The Scorecard appears after every hole played (except when you
are at the Driving Range or Putting Green). You can also access
the Scorecard from the Stats Menu.

* To page through the list, press B.




* D-Pad left/right to highlight the desired number of players.

and press A to confirm your choice. You may have up to 4
players.

« To return to the course, Pro Shop or PGA Tour Tent, press

Start. Aelecting a Player

\lter selecting the number of players, a box appears asking you
o select Player #1. This player can be a new human player, one
ol the ten Genesis pros, or an existing human player.

Select Player #1

Tourney Results

The Tourney Results Screen shows a list of all golfers who have
completed a tournament and their respective scores.

* To page through the list, press B.
« To return to the course, Pro Shop or PGA Tour Tent, press
Start.

PRACTICE ROUND

The Practice Round play mode offers flexibility of play without
the money pressure.

Plaving a Practice Round

« Select Practice Round from the Play Menu and press A. The
Select Number of Players Box appears.

* D-Pad up/down to highlight the desired player, and press A
to confirm your choice.

* Toselect a Genesis pro, highlight <Genesis> on the Select
Player Box, and press A. A list of the ten pros appears.

* Use the D-Pad to select one of the pros, and press A.

Selecting the Number of Players

Select Number of Players

'he program allows you to save up to 16 human players. If the
roster 1s full, the program indicates that there’s no more room for
new players. During a practice round, you can continue and play




with a golfer called “Player #1.” but the program doesn’t retain
his/her stats after the round is over. If you don’t want to play
with an anonymous player, press A for *OK” then C for

*Cancel’.
PLAYERS CARD E

Mame of player: Cindy

Alter you select a player, the program asks you to select a tee
position. Amateur Tees are closer to the green than Professional
lces. Amateur Tees are only available during a Practice Round.

Naming a \ew Player

| D-Pad left/right to highlight the tee you want.
2. Press A to confirm your selection.

Selecting Clubs for Your Bag

Press START when done

If you select New Player and there’s room for one, a Players
Card appears on the screen. It’s here that you name a new player,

|. D-Pad up/down to toggle through the upper and lower case
letters (there’s a blank space after the capital *Z").

2. D-Pad left/right to sclect a character and move on to the next
space.

3. When you're finished naming the golfer, press Start.

Alfter you select your tee, a Club Selection Box appears. You are
allowed 14 clubs in your bag including the putter, which you
always carry. The clubs in your bag appear in bold type, while

those not in your bag appear in pale type. Before you add a club
to your full bag, you must remove one.

If you wish to play with an anonymous golfer and not save his
stats, press C at the Players Card Screen. You'll play with a
generic player (#1, #2, #3, #4) as described above. This feature
is only available in a Practice Round.




ul players. the player himself, and the course. Each individual
player then enters their name with their own Controller, and
Jhooses their golf clubs and tees (during a Practice Round).
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|. D-Pad left/right/up/down to highlight the club you wish 1o
remove, then press B.

2. D-Pad left/right/up/down to highlight the club you wish to
add, then press B.

3. Repeat this process until you're done, then press A. The
Course Selection Box appears.

| ¢t's do a walk through:

| Ihree players decide to play a Practice Round and they each
decide to use their own controller. Player #1 activates Two or
\lore Controllers on the Setup Menu and selects Practice
Round from the Play Menu.

! Player #1 selects number of players (3).

| Player #1 selects either a new player, a Genesis pro or an
cvisting player for himself. He enters all tee and club
mlormation.

1 A Sclect Player #2 Screen appears. Player #1 must select with
( ontroller 1 either a new player, a Genesis pro, or an existing

Selecting a Course

. D-Pad up/down to
highlight the course you

e ———

B

e want. player and press A.
2. Press A to confirm your L Plaver # 2, with Controller 2, now enters the information
Forest of Arden shoice - k ; N e A fhe is . laver. he uses
choice. regarding club and tee selection. If he 1s a new player, he uses

Le Golf National An overhead view of the entire

his D-Pad to enter his name at the Player’s Card Screen.
6 After all three players have finished making their selections,
Player #1 selects the course.

- '

course appears, and an announcer
gives a brief weather report for the

day. The game begins at hole #1.
During a Practice Round, you can play through a course in
sequential order or skip around.

| his process (except for tee selection) is the same for Practice,
Skins, Tournament, Match Play and Shoot-Out game modes.

Two or More Players

The process of selecting and naming players, selecting clubs and
courses, varies a bit when you have two or more human players
and you've activated Two or More Controllers on the Setup

Menu. Player #1, using Controller 1, always selects the number




-: ¢+ Ihghlight Take a Mulligan from the Shot Menu, and press A.

Selecting a Hole

To Go to a Different Hole During a Practice Round:

|. Press Start to highlight the Menu Bar.

2. The Go to Menu is highlighted automatically, as well as the
Hole option. Press A to confirm. The Select Hole Box
appears.

. Use the D-Pad to highlight the hole you want, then press A
confirm your selection. You go to the new hole.

he program takes you back to your previous lie. Note that the
propram does not keep statistics for holes on which you take
wulligans, except for *Longest Drive’.

Picking up the Ball

Il vou're doing poorly on a hole and your frustration i1s
mounting, you can pick up your ball and accept a score of 12.

‘s

v Ihghlight Pick up Ball from the Shot Menu and press A.

TOURNAMENT PLAY

Now that you've mastered the basics and perfected your skills,
i« iime to put it all together and play a tournament. A
fourmament comprises four full rounds (72 holes) on the same
vourse. Sixty professional golfers, plus one to four players in
your party, compete for thousands of pounds in earnings. You
must use professional tees and mulligans are not allowed.

(hanging (ourses

To Go to a New Course During a Practice Round:

|. Press Start to highlight the Menu Bar.

2. Select New Course from the Go To Menu and press A to
confirm. The Select Course Box appears.

3. Use the D-Pad to highlight the course you want, then press A
to confirm your selection.

Now (o Play

Sav cood-bye to your buddies in the Pro Shop and choose
Lowrnament from the Play Menu. You are asked the same
questions as when you played a Practice Round (for complete
mstructions, see Practice Round on page 28).

After you make your selection, the program shows you an
overhead view and then takes you to the first tee of the new
course.

* Toexita Practice Round, select Pro Shop from the Go to

Menu and press A. ; .
d Aller you choose your course, an overhead shot of the entire

i . course appears. The Tournament Board then introduces the
Tﬂllﬁi MI"'!“ Wwurmament and total prize money.
In a Practice Round, you can take a shot over and over again
until you get it just right.
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During Tournament play, you return to the PGA Tour Tent
wither than the Pro Shop.

g " . . im’ w n inNdm

I'he Leader Board, which shows the current standings for all SKINS CHALLENGE

tournament participants, appears. I*ulifm'mg each ranking 1s the | wo to four players compete in a Skins Challenge for cash. The
player’s name, score, and the hole he is currently playing. sume is played over the course of 18 holes, with cach hole

waioned a monetary value. The value of the holes increases as
{ 1 q M .
“!l\ll! Lhe Cu .ou play and the size of the purse varies depending on the

' . g . i) W 11 i - 3 ‘ dYCIS.
{IC"UI'H”}'. i you H'H’Hﬂ p“r or hf"lfl' you “'I” |'I'|H|\'C th‘ cut. Al vounpetiion ll]l] [I'IL numhu ol rll i}n..r

the end of the first round, the top 48 players, plus all those
players tied for the lowest qualifying score, move on to the
second round. At the end of the second round, the top 32 players,
plus all those players tied for the lowest qualifying score, move
on and so on to the fourth and final round.

In order to win cash, you must win the skin for that specific hole.
|0 win a skin, you must win a hole outright by making a lower
~ore on that hole than each of the other competitors. If two
alayers tie for the lowest score on a given hole, the skin for that
hole carries over to the next hole. Theoretically, all 18 skins
could ride on the 18th hole. If no one wins the 18th hole, the




players return to the Ist hole and continue playing until somex
wins the remaining skin(s).

Since the total score for the round has no bearing on who wins
when one of the players clinches a skin on a given hole, the
other players simply pick up their balls and head to the next
hole. This is reflected on the Scorecard. If the winning player
scores a 3 for a hole, the other players show a score of 3+ on ¢
scorecard. This means that they would have taken more than 3
strokes to finish the hole, but simply went on as the competitio
was finished.

NATCH PLAY

One to two players compete against each other or against a
Genesis pro in three rounds of Match play.

\ complete game consists of three rounds with four groups of
‘wo playing consecutively. Each round is a single-elimination
Jntest and the competition is fierce. As in SKins, you try to win
“ach hole. but there are variations. Instead of each hole being
worth money, it is played for the sake of the score alone. If you
e or “halve’ a hole, the score remains the same.

\t the end of the round, whoever has won the most holes, wins
e round and proceeds to the next round of competition. The
wund continues only so long as there is uncertainty over the
sutcome. For example, if you have played 16 holes and are
down 3 holes, there is no chance that you could tie or win the
wund. and the round ends.

Il two players end a round tied, they return to the Ist hole for a
aidden death play-off. The winner of that play-off continues on
i the next round. The final winner takes all of the money, (there
sie no carnings for second or third place), so the pressure can be
wiense by the last round.

SHOOT-0UT

- Based on the Canon SHOOT-OUT Series, in
A our Shoot-Out play, four players line up to
i ) play three holes of golf. At cach hole, the
Canon player with the highest score is eliminated.
g The players who score the lowest on each
wole continue to the final hole where only two players are left to
compete for the final prize. Money is awarded for first and

wecond lﬂillﬂ:.




distance of each player’s ball (in inches) from the cup. If after
i te-breaker, players are still tied, then a second tie-breaker 1s
playved., and so on.

SAVING AND RESTORING
\ve bame

I he cartridge is designed to save only one game. When you save
4 pame you overwrite the previously saved game.

Rodger Davis
Davia Lee

v Sclect Save Game from the Options Menu, and press A.

|he program asks if it’s OK to overwrite the previously saved
game, (unless you haven’t yet saved any).

+ 1o overwrite the previously saved game, press A .

After you select a course, the program randomly selects a

| he came remains saved until another game is saved over it
starting hole. You play the next three holes in sequence.

Restore Game

t‘ ! 1‘_— .'t ¥ -IL-;-.‘- Y I l :. -'-:. '.' : : -T" :". f-l'!-'.-' -;E ‘t
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listence « Highlight Restore Game on the Options Menu, and press A
wice. The saved game appears and you continue where you

I8 H l.‘.I'ﬂ‘.

UValeriz Hanscom 23in.
David Lea 2l in.

Remember, you can also resume a game after leaving it if you
only 2o to the Pro Shop or PGA Tour Tent, and don’t exit the
procram entirely.

In the event of more than one player having the highest score at
a hole, a one-shot tie-breaker is played. The referee places the
ball randomly in a position close to the green. The shot can be a
chip or a putt, and each tying player takes the same shot. The
player farthest from the hole is eliminated. After cach of these
tie-breaker sessions, a Summary Box appears displaying the

<




* Highlight Resume Game on the Play Menu and press A. You

return Lo your game in progress.

FINE POINTS FROM THE MASTER

If you really want to get good at this game, you have to be awa
of all the factors that can influence the outcome of a given shot.

Ball Lie

The ball lies There are several different surfaces

in the rough | where thc ball can lie: tee, fairway,

green, fringe, rough, sand, etc. The latt

surfaces pose unique problems for the

golfer.

* Press A when not on the tee or the
green to see the ball lie.

The Tee— Every hole begins at the tee. Check your distance,
the wind gauge and the location of hazards. Make sure you hit
the accuracy point.

The Fairway— When you’re not on the green or the fringe, this
I the best place to be. Occasionally, you'll find your ball “in a
depression™ on the fairway. When your ball is in a depression,
the maximum distance for a given club is slightly reduced. and
the possibility for a wild shot is slightly increased.

I he Green— Knowing how to read a green is essential if you
want to shoot low scores. The putter is the only club allowed on
the oreen, and the wind is not a factor.

I he Fringe— The dark green area surrounding each green is
called the fringe. Here you can choose the putter or any other
(lub. If you're using the putter, make sure to use enough force to
putt through the fringe. On long shots, you might want to try a
chip shot. (See Special Shots, below).

I he Rough— The rough reduces the maximum distance
potential of any club you select, and increases the effect of a
hook or slice. If you're “Half-buried in the Rough,” these
consequences are greater still.

I he Heavy Rough— As you might expect, the heavy rough is
more undesirable than the ordinary rough. Nowhere is the “flub™
lictor more ominous. Exercise extreme caution and avoid using
the Draw/Fade Meter.

I he Sand— At all costs avoid the bunkers, especially the ones
along the fairway. It's extremely difficult to make an accurate
longe shot from the sand. If your ball is “Half-buried in the sand,”
vou might want to go with the sand wedge. Using a longer club
(4 one or two iron) to get distance is risky: the possibility of
hlowing the shot increases with a flat iron.

-
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I he Punch Shot

When you're half-buried in the rough, or buried in the sand,
wleet Punch Shot. This shot gets you back on the fairway and
out of trouble. The distance the ball travels is shorter than if you
wok a full swing, but you're less likely to shank the shot, and
have it sail wildly off your club face.

Special Shots

You'll discover a range of normal shots including “drive™,
“shoot™, “pitch™, “blast™, and “putt”™. In addition, there are three
special shots you can use when you're not on the green. They
found in the Shot Menu.

I he Fringe Putt

When you're on the fringe, you don’t have to use your putter.

| he program always selects Fringe Putt, but if you'd rather chip,
pitch. or punch, you can choose to do so. However, if you

Lhip Shot |. Press Start to reveal the change your shot type, and then change your mind again, you
Punch Shot f Menu Bar. can retrieve your putter by selecting Fringe Putt.
Fringe Putt 2. D-Pad right to display the Shot
v Normal Shet | Menu. Roll and Backspin
- 3. D-Pad down to highlight the

When aiming for the green, you want to account for roll and
bhackspin on the ball. You get backspin only on the green, only
when using a short iron, and only when shooting from the
[nirway or off the tee. Backspin takes effect after the first
hounce. The ball hits the green, bounces forward, then grabs on
the second bounce and rolls backward. If you hit the green with
1 wood from far away, the ball will rocket off the putting
wirface. If you hit the green with a medium to long iron, there’s
1 chance the ball may stop on the green after the first bounce,
provided the green is large enough.

Taks g My 13 an ‘

‘ ‘ special shot you want.
Pick up Ball a5 4

4. Press A to select that shot type.

The Chip Shot

I you are close to the green, or on the fringe, this is the perfect
time to use your Chip Shot. This shot does not fly very far in the
air. The strategy of the shot is to chip the ball just on to the green
and hope it rolls the rest of the way to the hole. If you use the
Chip Shot, be sure to read the contour grid of the green very
carefully. The moment your ball hits the green, it reacts to these
contours.

NOTE: A ball hit as a Chip Shot stops dead in its tracks if
it lands on the fringe.




(0ol the Best™ on the Enropean TOUR

{ olin Montgomerie

Rookie of the year in 1988 and winner of the
Tournament Players’ Championship in 1989,
Colin Montgomerie has been a force to be
reckoned with since he first made an
appearance on the Tour in 1987. Ambitious
and fiercely proud of his Scottish heritage,
Colin has won many fans with his buoyant
personality and his consistent and professional
play. He has improved his money list standing each season he
has been on the Tour. In 1992 he placed third on the Volvo
Order of Merit, and followed this by coming Ist in 1993.

PGA ECROPEANTOUR PRESS GUIDE
A Briel Wistory of the TOUR

The growth of the PGA European Tour since its inception in
1971 has been spectacularly successful, and its presence has
contributed a new and exciting chapter to the history of golf.
John Jacobs, Tournament Director General of the PGA, guided
the European Tournament Players’ Division Tour through its
first four years, establishing high standards for all to follow. In
1975, Ken Schofield became the newly named PGA European
Tour’s first Executive Director. The accomplishments of the
Tour have accumulated rapidly. The 1975 schedule of 17
tournaments restricted to an April-to-October season has more
than doubled to the present day 39 events on the Tour’s Volvo
Order of Merit. These tournaments, together with the developing
PGA European Challenge Tour and PGA European Seniors’
Tour, now afford incentive and opportunity to participants
through 12 months of the year. With players from more than 20
different nations participating in competitions held in 17
European countries, the European Tour has steadily increased its
standards of excellence. In 1993 there were 590 world-wide
entries for the Tour Qualifying School in France: only 40 were
graduated. Quite an illustration of excellence!

Rodger Davis
Australian Rodger Davis has had a long and

prosperous career spanning nearly twenty
years. Back in 1982, Rodger left golf all
together for eighteen months to start a
business of his own but was unable to stay
away from the game that he loved. He came
back and it was well worth while, both for
him and his many fans. In 1986, Rodger
vaulted to the top with victories at the PGA Championship and
the Australian Open. Subject to outside injury during the

lust few years, (one sustained while playing tennis), Rodger still
managed to post wins at the Volvo Masters in 1991, and the
Sanctuary Cove Classic in Australia in both 1991 and 1992. A
change to the “Langer” putting method helped him win the Air

I rance Open in 1993,

— adapted from the 1993 PGA European Tour Media Guide




Jos¢ Maria Olazabel

Named Rookie of the Year in 1986, José has
lived up to the potential displayed during a
truly magnificent amateur career. His brilli
play captured two tournaments in 1992,
Often compared with fellow Spaniard, Seve
Ballesteros, Jos¢ resists such comparisons,
graciously stating: “We look different, we
play different. I am not the next Seve, | am
the first me. By my age Seve had already won majors. He was
ahead of me, he has shown the way and I am trying to follow the
same path.” A great all-around player, he was the Tour Stats
Leader for Putts per Round in 1989. With many years of golf
ahead of him, Jos¢ should prove an exciting and dynamic player
to watch.

Bernhard Langer
Bernhard Langer has won at least every year
for the last fourteen years (as of 1993). King
Bernhard is a truly awesome player,
recognised world-wide, and capable of great
feats on the fairway and the green. An avid
skier, Bernhard refuses to let the fear of injury
keep him from the gratification of doing
‘ something he loves. Winner of the Harry
Vardon Trophy in 1981 and 1984, Bernhard is one of the leading
career money makers on the European Tour and has garnered
victories on both sides of the Atlantic. These include the Whyte
& Mackay PGA Championship in 1987 and the US Masters in

U85S He claimed his second US Masters title in 1993, together
with the the Volvo PGA Championship and the Volvo German
Open. With determination and character, Bernhard has left his
mark on the game of golf.

Sandy Lyle

After becoming the first British player to
triumph at Augusta in 1988, Sandy Lyle
experienced a three-year dry spell. He has
proved himself many times since turning pro
in 1977, and he was to do so again in 1991,
with a victory at the BMW International. He
continued playing well in 1992, officially
ending any suggestion of a slump, with a win
at the Lancia Martini Italian Open and an exciting play-off
victory at Valderamma against fellow Scotsman Colin
Montgomerie in the Volvo Masters. Sandy has come full circle
with this victory, calling it “my most crucial win since the US
Masters.” These latest victories gave him the honour of being the
vnth player to top £2 million in European earnings.

Ronan Rafferty

Ronan became the seventh player on the
PGA European Tour to pass £2 million in
prize money and scored his eighth European
victory when he beat Denmark’s Anders
Serensen at the first extra hole to take the
1993 Hohe Briicke Austrian Open at the
Colony Club in Vienna. It was Ronan’s first

- success in five title play-offs. However, 1989
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was his banner year. During that year, Ronan won the
Volvo Order of Merit, the Harry Vardon Trophy, and was the
Stats Leader in Greens in Regulation.

lan Woosnam

Possessed of a powerful game and an
indomitable spirit, lan Woosnam of Wales
proves that great things come in little

confidence, 1993 saw lan’s game peak during
August and September into victories in the
Murphy*s English Open, Trophée Lancome
and an unbeaten record in the Ryder Cup by
Johnnie Walker. Winning the Harry Vardon Trophy in both
1987 and 1990, lan is one of the toughest competitors on the
Tour. He has great distance on his drives, and was the Tour Sta
Leader in 1985 and 1987.

Costantino Rocca

During the 1993 season Costantino became t
first Italian winner on the Volvo Tour since
Massimo Mannelli in 1980 when he fired a
course record 63 for a first six-shot triumph in
the Open V33 du Grand Lyon. Having waited
over a decade for his maiden Tour success, he
had to wait only two months for his second -
the Peugeot Open de France, and when he
finished runner-up to lan Woosnam in the Murphy’s English
Open, Italy‘s wait for its first Ryder Cup player was over. “It’s a
great honour for my country as well as myself.” he said.

packages. A great believer in the power of self

Lony Johnstone

] 1992 was a very big year for Zimbabwe
native Tony Johnstone. He won the
prestigious Volvo PGA Championship at
Wentworth, earning for himself a cheque
worth £100,000, and perhaps what 1s more
important, a ten-year Tour exemption. With a
nearly perfect final round of 65, Tony edged
out for the win some of the finest golfers in
the world. Tony was in the money 17 times for 19 tournaments
entered that year: an impressive figure. He also has a world
ecord-equalling eight successive birdies, made during his 1990
win at the Murphy’s Cup. That event appears to be a lucky one
lor Tony, as he won it again in 1991,

Severiano Ballesteros

Winning his sixth Order of Merit in 1991,
Seve Ballesteros opened another brilhiant
season in 1992 with two PGA European
Tour titles in Dubai and Majorca (The Dubai
Desert Classic and the Turespana Open de
Baleares). One of the all-time greats of the
game, Seve has over 50 European Tour
tournament victories to his name, and an
amazing 17 additional victories. He has taken nearly every major
Litle and done much to improve the quality of play and
sundards of excellence world-wide. In the early 70°s when the
lour was in its infancy, a superstar was needed to excite the
inmagination of the public and the sponsors: Seve was that
wiperstar. Recently, he has continued to add to the game by

b‘ - 1-
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branching out to golf course design: the new | 7th hole at
Valderamma is one of his designs. Courageous and charming, he
remains a favorite with all aficionados of the game.

Courses and Tournaments in PG\ European Tour

Forest of Arden Hotel Golf and Country Club,
Warwickshire, England. Site of the English Open

While relatively young, the Arden Course of
£ <
=== ———  The Forest of Arden Hotel Golf and Country
F"HF\T "I' \HM'\ Club, 1s located in an area steeped in
___||||TFL__ tradition and historic importance. The
Sl 2 original Forest of Arden features
. prominently in Shakespeare’s “As
’ You Like It,” and it is likely that the

COUNTRY CLUB HOTELS | \,,0d from this forest was used in

the building of Henry VIII's navy.
Recently, the course has been improved and upgraded by the
famed designer Daniel Steel, along with European Golf Design,
at a cost of over one million pounds. At 7,102 yards long, the
Arden course has measured up to the standards of excellence
demanded by the PGA European Tour.

Wentworth Club, Virginia Water, Surrey, England.
Home of the Volvo PGA Championship

VOLV‘O The West Course at Wentworth, the

mmm — showplace of the London area courses, has
=== an unusual nickname. Known for its

length, it is called the Burma Road, a telling testimony to the
difticulty of some of its monster par-fours. Also home for more
than a quarter of a century to the World Match Play
( hampionship, Wentworth came to prominence in 1956 when it
hosted the Canada Cup, forerunner of the World Cup. It is one of
the most heavily wooded of the Surrey heath courses, and its
greens are more severely contoured than is normal for British
poll. Wentworth tests golfers in driving distance, accuracy and
putting ability, supplying golf fans the world over with dramatic
and superior events.

\ alderamma, Spain. Home of the Volvo Masters

] VOLVO Valderamma, as fiendishly difficult as it
METEHE is lavishly beautiful, was remodeled by

designer Robert Trent Jones at the request of Club President
lnime Ortiz-Patino. The goal was to turn it into a true
championship test prior to the inaugural Volvo Masters in the
autumn of 1988. The resulting course admirably satisfies that
poal. When the first players arrived, many were astonished by
the condition of the course. They had never seen such
immaculate fairways, while the greens were as fast and true as
those met with at an American Open. With views of the
Mediterranean and the Rock of Gibraltar, few courses can
compare with this jewel in the crown of Spain.

-
Bl
-
B
K
.




b
"
-

Le Golf National, Paris, France. Home of the Peugeot Open
de France.

It took vision and courage on the
part of the French Golf Federati
to look at a completely flat plot
land thirty-five kilometers outsi
Paris and transform it into the first *National® golf-course
complex in France. Together with their Chief Executive and
Principal Course Designer, Hubert Chesncau, the Federation
went ahead with their dream and created a *stadium style’ cou
complete with vicious water hazards and huge spectator moun
Now the home of the prestigious Peugeot Open de France, Le
Golf National offers competitive holes for the pros and optimu
views for the fans.

Crans-sur-Sierre, Switzerland. Home of the Canon
European Masters.
Canon
EUROPEAN MASTERS
CRANS MONTANA

o 000N AMN

Nestled amidst the imposing Swiss Alps,
the course at Crans-sur-Sierre has evolved
from the low-key site of the Swiss Open,
to the spectacular setting for the Canon European Masters. The
event and the course itself were transformed by the efforts of the
dynamic and remarkable Gaston Barras, a member of one of the
prominent local families. The thin air and high altitude of the
arca promote low scores and dramatic charges, but weather is
always a factor on this temperamental course. During the 1992

Lournament, all four seasons were represented, often within a
dnple hour, making it anything but simple for the pros to read
the course.

Lhe Canon SHOOT-OUT Series

- The Canon SHOOT-OUT Series 1s a special
pre-tournament event on the European Tour.
While drawing on all of a players’ skills, the
series also gives fans an additional
opportunity to watch their favorites compete.
I he series consists of eight regular shoot-outs and one final
which is held at Crans-sur-Sierre. The events take place before
mujor tournaments and earnings often go to the winning players’
wlected charities. The Canon Shoot-Out is very similar to the
version we include in this game, but it has 10 players competing
aver nine holes. There have been several different types of pre-
Wwurnament events staged on the PGA European Tour, but the

( anon Shoot-Out Series seems to be one of the most popular.
Spectators appreciate the format of the event, while the pros can
{est their skills in a more relaxed atmosphere. With the series
mcorporating more than 40 players from 17 different countries,
and with events staged all over the continent, many have come
1 enjoy this specialized form of competition.

— 1

Canon
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Background information for this manual obtained from Golf
Courses of the European Tour, The 1993 PGA European Tour
Media Guide, and The 1993 Volvo Tour Yearbook.The following
player names are used with permission of the PGA European

Tour:

Carl Mason

David Gilford

Jeft Hawkes

Jean Van de Velde

Hrett (}glﬂ

Hobert Karlsson
Stephen McAllister
ichard Boxall

I runk Nobilo
limie Spence
Peter Fowler

Liree Turmer

Faul Way

Mark James
Lordon Brand Jnr.
Sam lorrance
Darren Clarke
Faul McGinley
Danmiel Silva

Mark Roe

loakim Haeggman
Anders Forbrand
him Payne

“t'ﬁ ""il'l'lylh

Mark McNulty
Danny Mijovic
lun Palmer

Barry Lane

lesper Parnevik
Mike MclLean
Peter Baker

Mark Davis
Andrew Murray
lose Rivero

England
England
South Africa "
France '

(Hackeround information, cont.)

Australia
Sweden
Scotland
England
New Zealand
England
Austraha
New Zealand
England
England
Scotland
Scotland

N. Ireland
Ireland
Portugal
England
Sweden
Sweden
England
England
Zimbabwe
Canada
South Africa
England
Sweden
England
England
England
England
Spain
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(Background information, cont.)

David J. Russell England

Chris Moody England

Roger Chapman England

Stephen Ames Trimdad & Tobago
Wayne Westner South Africa
Per-Ulrik Johansson Sweden

Paul Broadhurst England

Brian Marchbank Scotland

Vijay Singh Fij
Gavin Levenson South Africa

Steven Richardson England
Peter Mitchell England
Ove Sellberg Sweden
Peter Fowler Australia
Eduardo Romero Argentina
Miguel Angel Jimenez Spain
Gary Orr Scotland

ELECTRONIC ARTS LIMITED WARRANTY

Electromic Arts warrants to the onginal purchaser of this Electronic Arts software product
that the medium on which this computer program is recorded s free from defects in
matenals and workmanship for a penod of minety (90) days from the date of purchase. This
Electrome Arts soltware program is sold “as 1s.” without express or imphied warranty of
kind, and Electromic Arts is not hable for any losses or damages of any Kind resulting from
use of thas program. Electromic Arts agrees Tor a peniod of minety (90) days to replace, free
charge. any Electronic Arts software product, postage paid. with prool of purchase, at the
Electrome Arts Warranty Department. This warranty is not applicable 1o normal wear and
tear. This warranty shall not be applicable and shall be voud 1f the defect in the Electromie
Arts Software product has ansen through abuse, unrcasonable use, mistreatment or neglect.
LIMITATIONS - THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES
AND NO OTHER REPRESENTATIONS OR CLAIMS OF ANY NATURE SHALL BE
BINDING ON OR OBLIGATE ELECTRONIC ARTS. ANY IMPLIED WARRANTIES
APPLICABLE TO THIS SOFTWARE PRODUCT, INCLUDING WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE

LIMITED TO THE NINETY (90) DAY PERIOD DESCRIBED ABOVE. IN NO EVENT
Wil ELECTRONIC ARTS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES RESULTING FROM POSSESSION, USE OR
MALTFUNCTION OF THIS ELECTRONIC ARTS SOFTWARE PRODUCT.

Lo states do not allow limitations as to how long an implied warranty lasts and or
¢odlumons or mitations of incidental or consequential damages so the above limitations
sl or exclusions of hability may not apply to you. This warranty gives you specific nghts,
sl vou may also have other rights which vary from state to state.

i 1URNS AFTER WARRANTY - To replace defective media after the minety (90) day
wartanty period has expired, send the original cartridge to Electronic Arts” address below.
Lo lose a statement of the defect, your name, your return address, and a check or money
aider lor "h:“t"]

 lectromic Arts

L ustomer Warranty
PFi) Box 7578
San Mateo, Cahforma 94403-7578

I vou need to talk 1o someone about this product, call us at (415) 572-9448 Monday through
Finday between 8:30 am and 4:30 pm, Pacific Time.

In Australia and New Zealand, contact:
I lectronic Ants Pry. Limited

PO Box 432

Southport Qld 4215

Austrahia

Within Australia call:
Phone (075) 711 811

Within New Zealand call;
Phone: <61 75711 811
bt een Yam-5pm Eastern Standard Time

L nless indicated otherwise, all software and documentation 1s © 1994 Electronic Arts. All

I.I“-l.ra. Reserved.

I A SPORTS, the EA SPORTS logo, 4-Way Play, the 4-Way Play logo, are all trademarks of
 lectromic Arts.

PO Luropean Tour is a trademark and PGA TOUR s a registered trademark, and are used
by poermission,

VD oumament names and logos are the property of their respective owners.

LICENSED BY SEGA ENTERPRISES, LTD. FOR PLAY ON THE SEGA™ GENESIS™
SYSTEM.

LG AAND GENESIS ARE TRADEMARKS OF SEGA ENTERPRISES, LTD.
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ABOUT THE ARTISTS

Dennis Koble and Lee Actor — Polygames
Lee Actor and Dennis Koble formed Polygames in 1988 to
bring together their diverse talents for creating entertainment
software. With over thirty impressive software titles to their
credit, PGA European Tour stands as one of their finest
ctlorts.

L.ee and Dennis are inveterate golfers, who attempt to hack
their way around a local course at least once every week or
two. They’d like to tell you they're scratch handicappers,
and they are—as long as they’re playing PGA European
Tour.
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THIS WIL
CHANGE THE

4 Way Play lets up to four
players compete at the
same time. Perfect for
tournament play.

2on2;30n1; The sports games you want-the way you
OF & V8. COmpARer. want to play. Only from EA SPORTS.

735305 =\

Choose 20on 1;




